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Pima County
Land Information System (PCLIS)
License Agreement.

BY USING THE ENCLOSED SOFTWARE YOU INDICATE YOUR ACCEPTANCE OF
THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THESE TERMS
YOU MAY RETURN THIS PACKAGE (INCLUDING ALL ACCOMPANYING ITEMS) TO
THE PLACE YOU OBTAINED IT FOR A REFUND.

The PCLIS (hereafter "Program”) provided under this License Agreement is licensed, not
sold. You obtain no rights other than those specifically granted to you under this license.
The term "Program” means the original and all whole or partial copies of it, including
modified copies or portions merged into other programs. Pima County (hereafter
"County"), retains title to the Program. The Program provided under this Agreement may
contain or be derived from portions of material provided by third parties. County has
assumed the responsibility for selection of such materials and their use in the Program
licensed hereunder. Nevertheless, you, and neither County nor such third parties, are
responsible for the selection of the Program for your purposes, and for the installation of,
use of, and results obtained from the Program.

License

Under this license, you may: use the Program only on one machine; copy the Program for
backup, provided your backup copy is not installed or used on any computer; and transfer
possession of the Program to another party. If you transfer the Program, you must transfer
a copy of this license, all other documentation and at least one complete, unaltered copy
of the Program to the other party. You must, at the same time, either transfer all your
other copies of the Program to the other party or destroy them, then terminated. The other
party agrees to these terms and conditions by its first use of the Program. You may not
use, copy, modify, merge or transfer copies of the Program except as provided in this
license. You may not lend, sublicense, rent, lease or assign the Program.

Limited Warranty, Media

County warrants that for a period of ninety days after delivery to the original user, as
evidenced by a receipt, the Program shall conform substantially to the specifications as
set forth in the documentation relating thereto, and both County and all of its licensors
expressly disclaim all other warranties, express or implied, including, but not limited to, the
implied warranties of merchantability and/or fithess for a particular purpose. County's sole
responsibility shall be, at County's sole option, to:

(1) modify or replace the Program so that the Program, as modified or replaced, conforms
substantially to the specifications; or

(2) to refund the original purchase price, as evidenced by a receipt.

Limitation of Remedies

County shall have no other liability with regard to the Program. County does not warrant
that the Program will meet the requirements of Licensee or that the operation of the
Program will be error free, or that Program defects will be corrected. The entire risk as to
the quality and usefulness of the data and the entire risk arising out of the use or
performance of this Program and documentation rests with Licensee. In no event shall
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County, or anyone else involved in the creation, production or delivery of this Program, be
liable for any damages whatsoever whether in contract or in tort, including but not limited
to lost profits, lost savings, lost data, business interruption, computer failure or
malfunction, or other pecuniary loss or any direct, indirect or incidental damages or other
economic consequential damages, or for any claim or demand against Licensee by any
other party, arising out of the use or inability to use this Program, even if County, or
anyone else involved in the creation, production or delivery of this Program, has been
advised of the possibility of such damages.

The limitation of remedies described in this Section also apply to any third-party supplier
of materials to County. The limitations of liabilities of County and its third-party suppliers
are not cumulative. Each such third-party supplier is an intended beneficiary of this
Section.

Restricted Use; Copyright; Public Works Technical Services Division Logotype Information
in the Program may be subject to restricted use policies, including copyrights. Licensee is
expected to consult each document for further information. The Program is owned by
County and its suppliers, and its structure, organization and code are the valuable trade
secrets of County and its suppliers. The Program is also protected by United States
Copyright Law and International Treaty provisions. You must treat the Program just as you
would any other copyrighted material, such as a book. You may not copy the Program
except as set forth in this License. Any copies that you are permitted to make pursuant to
this Agreement must contain the same copyright and other proprietary notices that appear
on or in the Program. You may not modify, adapt, translate, reverse engineer, decompile,
disassemble or otherwise attempt to discover the source code of the Program. Where the
Public Works Technical Services Division logotype appears on a document, it shall not be
removed or obscured. It shall be clearly displayed on all copies or reproductions of the
document. Except as stated above, this Agreement does not grant you any intellectual
property rights in the Program. You may copy and modify the Avenue scripts contained in
the PCLIS project (.apr) files to suit your own application needs.

Caution

The data contained in the Program: comes from many diverse sources; is actively being
worked on by County; is subject to constant change; and may not be complete, accurate
or up-to-date. The x,y coordinates may be in error by several hundred correctly. All data is
provided as is, with all faults. The data is intended only to depict approximate locations.

General

You may terminate your license at any time. County may terminate your license if you fail
to comply with the terms and conditions of this license. In either event, you must destroy
all your copies of the Program. This license is governed by the laws of the State of
Arizona, without reference to the choice of law provisions of Arizona law.

Acknowledgment

You acknowledge that you have read this Agreement, understand it, and agree to be
bound by its terms and conditions. You also agree that this Agreement is the only
agreement between you and County and cannot be modified by any purchase orders,
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advertising or other representations by anyone, unless, a written amendment has been
signed by an authorized officer of County.

Credits

ArcView, Avenue and Data Publisher are trademarks of Environmental Systems Research
Institute (ESRI). Portions of this work include intellectual property of ESRI and are used
herein by permission. Copyright © 1997 ESRI. All rights reserved.
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|. OVERVIEW

The Pima County Land Information System (PCLIS) CD contains a collection of Pima
County GIS datasets, tools for querying and analyzing this data, and setup program to
install the data and program for you. (See “The Program” section below for more detail.)

A. The Data

The data included on this CD was converted by various federal, state, county and
municipal agencies from paper maps and other manual sources over a number of years.
As a result, data quality is uneven and there are known errors in the data sets. For
example, most layers on this CD are from several months to several years out of date.
Also, the layers are registered to a variety of basemaps, and line up only approximately
with other layers on the CD.

Our purpose in distributing these layers is twofold: (1) to provide broader access to data
that has proven useful to County agencies for very coarse, regional analyses, and (2) to
begin a dialog with the user-community about the who, what, when, where and how of
resources to maintain more accurate and timely geographic data sets in Pima County.

UNDER NO CIRCUMSTANCES SHOULD THIS INFORMATION BE USED FOR
ENGINEERING OR LEGAL PURPOSES. PLEASE READ THE LICENSE AGREEMENT
THAT APPEARS AFTER THE TITLE PAGE TO THIS DOCUMENT AND UPON
INITIATION OF THE GIS PCLIS.

More detailed information about each of the datasets on this CD can be found in the
“About the Data” option under the help pull down menu inside the program.

B. The Program

This CD includes GIS data sets, a project-locked version of ArcView 2.1B
(GISAVDP.EXE), a project file that is locked to ArcView 2.1B (GISAVDP.APR), and a
project file that is compatible with the full version of ArcView 2.1B (GISQUER2.APR).
NOTE: Project locked ArcView only runs with the GISAVDP.APR project file and is
missing some of the functionality present in a full version of ArcView. Specifically the
creation of new documents, geocoding, and image linking functions have been disabled.
In terms of the PCLIS application this means that you cannot zoom to road intersections
or use the “map pin” tool to find an address using the street network file. All other PCLIS
functions are operable.
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C. Product Support Policies

Please note: NEITHER PIMA COUNTY NOR ESRI PROVIDE TECHNICAL SUPPORT
FOR THE PROGRAMS OR DATA ON THE CD. However, there are several avenues for
you to get help:

User Manual
This user manual is found on the CD and at the root of the path to which you installed the
PCLIS program:

e User2lb.txt - A text version of the user manual
e User21b.doc - A user manual in Microsoft Word

It has many tips and basic instructions to get you going. This manual is not a guide to all
ArcView functionality. You can purchase additional ArcView training and/or books from
ESRI or many other private companies.

Help Menu
There are many help options accessible from the help pull-down menus inside the PCLIS

program. Many times the answer to your general ArcView questions will be found here.

Email and Mail

Pima County DOT, Technical Services Division has established the following e-mail
address for you to send us comments and questions about the PC Land Information
System. pclis@dot.co.pima.az.us

As time allows, we will try respond to your e-mail, but we cannot guarantee a response.
We will consider your input when making revisions to future releases. Program
improvements and data updates will be available by purchasing subsequent editions of
the CD. No interim updates or patches will be provided. Please let us know if you have
suggestions for improving the data and/or the application. We want to hear from you.

You can also mail comments to:

CD-ROM Group

Pima County Department of Transportation
Technical Services Division

201 N. Stone Avenue, Suite 910

Tucson, AZ 85701

WE ARE SORRY THAT DUE TO RESOURCE CONSTRAINTS WE CANNOT ACCEPT
PHONE CALLS RELATED TO THIS PRODUCT.
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[I. SYSTEM REQUIREMENTS

A fairly robust PC is required to effectively view and analyze the data on this CD. Below
are the minimum system requirements, with our recommendations for better performance
in parentheses.

IBM PC Compatible computer with:

* 486-66 MHz or higher processor (Pentium recommended)

32 MB of RAM (64 MB recommended)

 CD-ROM drive

» 550 MB of free hard drive space to hold data files, Basic Install (750 MB for Full Data
Install) OR a 6X or faster CD-ROM to load data directly from the CD-ROM.

* Windows 95, Windows 98 or Windows NT 3.51 or 4.0

* Project-locked ArcView 2.1B (included on the CD), or a full version of ArcView 2.1B or
higher for full functionality.

Updates
Updates containing newer data and program improvements are anticipated quarterly.
Program improvements and data updates will be available by purchasing subsequent

editions of the CD. Updates will be announced on our web page,
www.dot.co.pima.az.us, on the SAGIS-L listserver, and on the PCLIS_L listserver.
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[Il. INSTALLATION

A. Installation Options
The PCLIS CD can be run on Windows 95, 98, 2000, NT 3.51, and NT 4.0 with "Addition
Data” stored on either the CD ROM or hard disk.

Operating Systems
ArcView is 32-bit application, which means it runs best and fastest in a 32-bit operating
system like Windows 95 or Windows NT. We strongly recommend a 32-bit operating
system for reliable operation. The installation program only accommodates 32-bit installs.

Source Media for Data
The GIS Query Program and basic Data Layers will be installed to the hard drive but will
access all the Additional Data directly from the CD (Basic Install). From the Help menu -
Admin tools you can copy data layers (specific to your needs) to your hard drive. This has
been done to reduce to space require on your hard drive.
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B. Installation Instructions

Warning to users upgrading or reinstalling:
Delete or move any existing shape files (.shp, .shx, .dbf) and index files (.ain, .aih, .sbx,
.sbn, .ixs, .mxs) from the directory where you plan to install the new PCLIS.

1. Place the CD in your CD-ROM reader and close the door.

2. From the Program Manager (WinNT 3.51) or the Start Menu (Win95 or WIinNT 4.0)
select “Run.”

3. Browse to <cd-rom drive>:\pclis\setup.exe, highlight and double click.

4. Select OK

5. Follow the install wizard prompts to complete the installation.

The Setup screen confuses some people. To make the correct selection use the following
format:

Determine the correct operating system (Win95, WinNT).

Determine the correct software (PCLIS only, or PCLIS and Data Publisher).
Determine where the Additional Data will reside (CD-ROM or Hard Drive).
Highlight the proper line by positioning the pointing device over your selection
and left-clicking.

Left-click “Next” button to continue installation.

PonE

o
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V. OPERATION

A. ArcView Basics

1. Views and Themes

A View is a collection of geographic datasets called themes. The View window
contains two parts, the table of contents and the map display.

The Table of Contents, part of the View window, displays the legend for each theme in
the project and is where you control the drawing order, visibility and active states for
each theme.

A Theme is a logical collection of geographic features with similar characteristics. For
example, you might have a view called The State, which contains two themes, the
major highways and the major water courses. The two themes appear in one view
because they have the same geographic extent.

2. Visible Themes, Active Themes and Drawing Order

Themes are made Visible or invisible by clicking the check

) |
box next to the theme name in the table of contents. _ +1r
Turning the themes visibility off only affects the display ¥ Regional PE’E’E'EH
properties of the theme. It does not affect the data in any [

way. In the example to the right, Regional Parcels, Street | Street Network
Center Lines and Pima County Boundary will be drawn in

the map display area while the Street Network will not. o] Street Center Lir

To make a theme Active, click on the theme name in the N
table of contents. When the theme becomes active it will ¥ FimaCounty Bo
appear to raise off the canvas and is ready and available - -

for theme operations. The Street Center Line theme is
shown as the active theme in the example to the right.

ArcView draws themes in the map display sequentially starting with the theme at the
bottom of the Table of Contents. To change the order in which a theme draws, place
the cursor over the them in the Table of Contents, hold down the mouse button, then
drag the theme to a new position (up or down) in the Table of Contents.

3. Active Windows

To perform operations in the view, tables or other ArcView windows, the chosen
window must be the Active window. To make a window the Active window, simply click
the pointing device anywhere within its boundaries. The title bar of the window
changes its appearance to indicate it is Active. Note the preferred method of changing
between windows is to click on the Title Bars or use the Window menu.
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4. Theme Classification (index)

There are a multitude of ways you can apply Classification to the theme’s legend.
Double-clicking the theme name in the Table of Contents brings up the Legend Editor
menu. This menu lets you choose the method to best represent the data. The menu
has five different legend types. Some of these have additional options such as
classification fields, normalization fields, and color ramp choices.

Note: PCLIS has classified and symbolized many of the themes for you, but a few of
the less often used themes will appear with only rudimentary symbolization.
B. Overview Of Menus, Buttons And Tools

The PCLIS is a windows-based application which means that most of the time you will be
using a mouse to make selections from menus, buttons, or tools.

Since the PCLIS is an ArcView-based application, it follows the same, document-based,
interface paradigm as ArcView. ArcView has five basic document types, each with its
own set of menus, buttons, and tool bars:

* Projects
* Views

* Layouts
* Charts

e Scripts

Each of these sets of menus, buttons, and tool bars is called a Graphical User Interface
or GUI. The PCLIS has modified only the View-document GUI significantly, and so that is
the GUI that is described in detail below. All the other document GUI's are mostly
standard, and the on-line help will explain the menus, buttons and tools available in each.
Where one of these GUI's has been modified, it is noted in the following section.

1. The Standard View Menu

Pima County Land Information System for Arc¥iew 2.1b - Yersion 2.0 .
File Edit View Graphics Theme Window »)»>» Locate By Display Analyses Maps (< Help

Will notice that the standard ArcView menu items appear on the left side of the GUI and
all the PCLIS menu items appear on the right, between the arrows (>>>> <<<<<):
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The first PCLIS menu item is LOCATE BY:

Lﬂﬂﬂtl‘- =8 Display A This menu offers you many choices of geographic areas to
Parcel ... select and zoom to.

Subdivision Name...

TownshipfSection... When any one of these menu items is selected, one or more
Special District... dialogue boxes will appear allowing you to input the necessary
Political District... information for the selection process.

Incorporated Area...
Statistical District...

Parcel... - This menu item is used to select one or more parcels. The PCLIS program will
search the data base, using the one of five (5) methods, and select and zoom to the
parcels meeting the given criteria. The following dialogue box is displayed allowing you to
choose the method by which you wish to search for and select the parcel.

I Parcel S5election Methods I

Select Parcel[s] By 0K
Cancel | |
Address e
Owner's Name
Book { Map
Map { Plat [
*
e

Taxcode — When this method is selected, you are given a choice to select a single parcel
or to select multiple parcels that are within a range.

Single Parcel - Enter a valid taxcode number. If the number you entered is not found
in the database, you will be presented with a list of codes that match the first 5
characters of the code which you entered. Pick a taxcode number and click OK, or
double-click a taxcode number, and the standard view will zoom in at 1:6800 scale,
with the selected parcel, hatched and shaded, in the center of the view. If no match is
found on the first five numbers the program will return an error message.

Parcels within a Range — This operation can take a few minutes depending on the
number of parcels in the range and therefore a reminder message will appear. Click
OK to dismiss the message then enter the lowest valid taxcode number of the range,
click OK. Then enter the highest valid taxcode number of the range and click OK. The
standard view will zoom in to the selected parcels, and display them shaded, in the
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center of the view. If no match is found on the first five numbers the program will
return an error message.

Address — When this method is selected, a dialogue box is displayed allowing you to
enter an address number, a directional prefix, and finally a street name. The standard
view will zoom in at 1:6800 scale to the selected parcel, and show it hatched and shaded,
in the center of the view. If an exact match is not found, you will be presented with a
scroll list of addresses that match the address number and/or the first five characters of
the street name you entered. Pick an address and click OK, or double-click an address,
and then standard view will zoom in as previously stated.

Owner's Name — When this method is selected, the dialogue box will prompt you to
“Enter the first five characters of the owner's last name”. The PCLIS program will then
present a scroll list of owner's names that match on the first five characters. Pick a name
and click OK, or double-click a name, and the standard view will zoom in at 1:6800 scale,
with the selected parcel, hatched shaded, in the center of the view.

Book / Map — This method uses the assessor’'s book and map numbers to select and
zoom into parcels. You are presented with a dialogue box to enter these numbers.

Map / Plat — This method uses the assessor's map and plat numbers to select and zoom
into parcels. You are presented with a dialogue box to enter these numbers.

The next six menu items, in the Locate menu, all prompt (via dialogue box) for a specific
geographic area to select and zoom to.

Subdivision Name... - The dialogue box prompts for you to enter at least five characters
of the subdivision name. The PCLIS will then generate a list of subdivision whose first five
characters match what was entered. A new dialogue box will appear showing the results
of this search and allow you to select the desired subdivision to zoom to.

Township/Section... - The dialogue box prompts for you to enter a township and range
(e.g. el313, which is Township 13 South, Range 13 East), or a township, range and
section (e.g., 131301, which is Township 13 South, Range 13 East, Section 1). The
PCLIS will then select and zoom to the specified Township or Section.

Special District... - The first dialogue box to appear prompts for which one of the special-
district categories to use. The second prompts for the specific district or panel number to
select and zoom to. The special-district categories to choose from are:

Fire FIRM Panel
School
Political District... - The first dialogue box to appear prompts for which one of the

political-district categories to use. The second prompts for the specific district number or
Indian Nation to select and zoom to. The political-district categories to choose from are:
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Board Districts Tribal Districts
Council Districts

Incorporated Areas... — This menu item produces a dialogue box with a list of
incorporated areas. Choose an area and click OK, the PCLIS will then select and zoom to
the chosen incorporated area.

Statistical District — Again the first dialogue box prompts for one of statistical-district
categories and the second for the specific area. The statistical-district categories to
choose from are:

Census Tracts Census Block Groups
Census Blocks Traffic Analysis Zones

Road Intersection... [Full Version, Only] — A pop-up message box showing the correct
input format (e.g. N. Thornydale Rd. & W. Ina Rd) appears when this item is selected.
Enter the Street intersection per the example. Both street names entered must have a
directional prefix, a streetname and a street-type suffix. Also, a "&" character must
separate the two streets.

The second PCLIS menu is DISPLAY.

Display Layer[s]... layers to both the Standard and Index Views.

Hemowve Layer|s]...

Add Layer|s] to Index View -
Remove Layer[s] from Index Yiew I

Display Layer(s)... - This function presents you with a scrolling list of all layers available
on the CD-ROM. Double clicking on a Layer name or selecting one and clicking OK wiill
add it to the Standard View Window. You are then given an option for adding another
layer.

Remove Layer(s) - The remove function presents you with a scrolling list of layers
present in the standard view table of contents. To remove a layer, select it from the list
and click OK. It will then appear in the list with a check mark indicating it has been
selected. You may select up to 5 layers to be removed at one time. You may also deselect
a layer by selecting it and clicking OK. When the layer or layers have been selected,
choose Done and click OK to remove them. This function also removes the layer(s) from
the Index View.

Add Layer(s) to Index View - This function allows you to add layers, present in the
Standard View, to the Index View.

Remove Layer(s) from Index View — This function allows you remove layers from the
Index View without removing them from the Standard View.
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The third PCLIS menu is ANALYSES.

ORI Maps <<<{<{<{<{ Help

Geocoding... From the ANALYSES menu, you can choose any one of
Proximity... three standard GIS analyses.

Parcel Analysis

Parcel Identify This menu includes functions to Set and View the

Set Parcel Analysis Defaults default setting for the Parcel Analysis function.

YView Parcel Analysis Defaults

Geocoding... [full version, only] - this function allows you to create a pin map from a .dbf
format file that has all address information (street number, prefix name, and suffix) in a
single field. You browse to the location of the file, select the file, specify the field in the .dbf
file that contains the address information, then wait, as the address are matched points
are created. A new point shape and dbf file database is created and stored on disk as a
result of this operation.

Proximity... - this function displays a dialogue box for selection of Proximity Analysis.
The four (4) types are described below.

Features Nearest To Selected Feature — finds the closest feature, of an active and
visible layer, to another selected feature (of the same or a different active and visible
layer). The first dialogue box prompts “Find the feature in” and to “Choose a Layer”.
The available layers will be listed in the scrolling dialogue area of the box. The
second dialogue box prompts “That is Nearest to the Selected Feature in” and to
“Choose a Layer”. Once the layers are selected, the PCLIS program will find and
select the nearest feature and display the distance between the two features. This
function does not change the display (zoom in).

Features Near Other Features — uses the selected single feature in one active and
visible theme and finds all features in another active and visible theme that fall within a
specified distance. The first dialogue box prompts for the layer whose selected feature
will be use to find the feature of another layer. The second dialogue box prompts for
the layer whose features you are search for. The third prompts for the maximum
distance for the search. You are then prompted to select items or data fields to be
included in the proximity analysis report. This last dialogue box allows for multi-
selections. Select an item then select OK for each item to be included. Select Done
(the last item in the list) and select OK to run the analysis. Note: If you do not wish a
analysis report select Done and OK and the function will run and only report the
number of features selected.

Layer Features Near Selected Parcel — uses the selected parcel to find all features in
an user-selected theme that fall within a user-specified distance. One and only one
parcel must be selected and the theme in which to search for proximal features must
be active and visible prior to selecting this function. You are prompted to select from
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the active, visible layers, input the search distance and to select items for the proximity
analysis report.

» Parcels Near Selected Layer Features — uses a selected feature in an active and
visible theme to find all parcels that fall within a user-specified distance. One and only
one feature may be selected in the user-specified theme. Again you will be prompted
to select from the active, visible layers (only if more than is active) input the search
distance and to select items for the proximity analysis report.

Parcel Analysis — When this menu item is selected the PCLIS program generates a
report on a selected parcel that includes data from selected default layers. The last two
menu items are use to set and view the defaults.
Set Parcel Analysis Defaults - Presents you with a scrolling list of all layers available
on the CD-ROM. Select the layers whose data will be include in the Parcel Analysis
report.

View Parcel Analysis Defaults — Displays the currently selected layers whose data
will be included in the Parcel Analysis Report.

Parcel Tax Report - This menu item generates a report, for a selected parcel, using the
Assessor’s Tax Master data.

The last PCLIS menu is MAPS.

Standard View MAP - This menu item creates a standard

RETER <{<{<<< Help 8-1/2 x 11 map. What ever is visible in the standard view will
Standard View Map be put onto an ArcView layout for printing to your printer or
plotter.
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The last menu is HELP.

Help
Contents

Views... - HELP — This menu is made up of both the standard
1 Search For Help On... | help screens for ArcView (AV) and those of the PCLIS
| QObtaining Technical Support... | (PCLIS) program.

How to Get Help...
About ArcView...

About the Data...
Product Support
Admin Tools...

Contents (AV) - Categorized help.

Views (AV) - Display, query, creation, and analysis with views.

Search for Help On (AV) - Search tool to locate commands and AV subject information.
Obtaining Technical Support (AV) - Environmental Systems Research Institute’s
technical support options. (Note: If you do not have ArcView and are using the project
locked version that comes on the PCLIS for ArcView CD, no support is available from
ESRI.)

How to Get Help (AV)

About ArcView —(AV) - Product information.

About the Data (PCLIS) - Metadata about the themes and field definitions.

Admin Tools (PCLIS) - Alias, indexing, and Data Install tools.

A menu item Create CDF from Selected Parcels has also been added to the FILE menu
for use with the Data Publisher version. This menu item generates a comma delimited text

file called Taxinfo.out for the selected parcels. This file is stored in the /AZITEMP
directory and can be imported into many dbase programs.

AV2.1.D0C 10/2/2002



1. Standard View Buttons

The button bar is the first row underneath the pull down menus, at the top of the
application window. Standard ArcView buttons are noted as such, and a more complete
description of these buttons can be found in the ArcView help tool by selecting the
"?/arrow" button and clicking on the button for which you need an explanation. Also, you
can move the cursor over each button and see a one-line explanation of its function in the
status bar (at the bottom of the application window).

= “Floppy Disk” (Standard - Full Version Only) - saves changes to the project file. In
= the run-time version of ArcView, you cannot save any changes to the project file, so
this button is invisible in the GUI.

“PushPin” (Standard) - displays a dialog box allowing you to type in and locate an
address. This pin is only active when the street network theme is active.

[Note: A theme is active when it appears to protrude from the legend area. You can
toggle the theme between active and inactive by left clicking any vacant area next to its
name.]

% “Three Pages” (Standard) - zooms the active window to the extent of all themes in
the legend. For example, if you had one eastern Pima County Theme and one
western Pima County theme in the legend, the view would zoom to all of Pima
County.

A “Two Pages” (Standard) - zoom the active window to the extent of all ACTIVE

—-1 themes in the legend. For example, if only an eastern Pima County theme was
active, even though another western Pima County theme was showing in the
legend, the view would only zoom to eastern Pima County.

“Boxes on Page” (Standard) - zoom the active window to the extent of selected
features in the active theme. For example if you had a city boundary theme in the
legend and had selected just the City of Tucson boundary, then clicking this button
would zoom the active view to just the extent of the City boundary.

“One Page” (Custom) - zoom the active window back to the previously zoomed
area.
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“Three Dots” (Standard) - unselect the features of all active themes.

“?/Arrow” (Standard) - changes the cursor to a question mark and allows you to
click on any portion of the application window to get context-sensitive help about
that part of the ArcView application.

“Diagonal Pen with Plus Sign” (Standard) - toggle the legend visibility for active
themes in the Standard View.

“Hammer and Question Mark” (Standard) - start the ArcView query tool to build a
query expression that will select a subset of features in the active themes.

“Grid over Paper” (Standard) - display the database table for the active themes.
This tool is very useful to see the selected records after you have graphically
selected features in a theme. Select some features, ensure that the theme in
which you selected the features is the only active theme, then click the table button.
In the table GUI find and click the “up arrow” button to promote the selected records
to the top.

“Binoculars” (Custom) — starts the parcel selection process. See Parcel listed
under the “Locate By” menu for detailed information.

| “Plus sign over paper” (Custom) — starts the Add Layer(s) function. See Add

Layer(s) under the “Display” menu for detailed information.

“Fading X” (Custom) — starts the Remove Layer(s) function. See Remove Layer(s)
under the “Display” menu for detailed information.

“Filed paper” (Custom) - generates a report, for a selected parcel, using the
Assessor's Mass Model data. This data specifies the number of stories and, rooms,
wall and roof type, type of heating and cooling, etc ..

“Linked Tables” (Custom) - generates a new dbf table of parcel data from the
Assessor's Residential Mass Model data table, for parcels meeting specific user
supplied criteria.
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[=] “Two Brackets” (Custom) - creates mail labels for the selected parcel(s). You

choose situs (property) or owner’s addresses, whether you wish to place the parcel
ID on each label, and one of three Avery standard label formats (5160, 5161, or 5162).
(Windows 95 Users, Please Note: After you have specified all your mail label options and
click OK, a “dll error” message will appear on screen. Just click OK and let the program
proceed. Mail labels are created normally. This error occurs because the mail label
program was compiled on an NT platform and is not completely Win95 compatible.)

3. Standard View Tool Bar

ONEREFT [EFET ADRE

The tool bar is the third row at the top of the application window. Standard ArcView tools
are noted as such, and a more complete description of these tools can be found in the
ArcView help tool by selecting the "?/arrow" button and clicking on the tool for which you
need an explanation. Also, you can move the cursor over each tool and see a brief, one-
line explanation of its function in the status bar (at the bottom of the application window).

“i” (Standard) - retrieves database information about a feature in an active theme
when that feature is left clicked with this tool.

“Arrow” (Standard) - selects shapes or points by clicking or dragging a box. This
is the tool that you will use most often because it is innocuous: it doesn't change
anything or start long computational processes if you accidentally click in the wrong
place in a view window.

> e

“Square” (Standard) - selects features in the visible, active themes by clicking or
dragging a box. You can toggle features in and out of the selected set by holding
down the shift key as you click on a feature with your mouse.

“Plus magnifying glass” (Standard) - zoom in on a point you click or a box you
click-and-hold to drag.

“Minus magnifying glass” (Standard) - zoom out on a point you click or a box you
click-and-hold to drag.

'O G/ 1=

“Hand” (Standard) - pan the standard or index views by click-and-holding then
dragging inside the view window in any direction.
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“Ruler” (Standard) - measure the distance between two or more points by left
clicking on both the starting and ending point. To exit this function, either double-
click anywhere in the view, or select another tool.

“Tag” (Standard) - label features with graphic text using database attributes. You
must have set the THEME, PROPERTIES, TEXT LABELS parameters before
labeling theme features. The text labeling properties can be set before, during or
after the labeling task using the SYMBOL PALETTE option off of the WINDOW
pull-down menu.

“T” (Standard) - create text on the display by clicking the location for the text,
typing it in the box provided, then positioning it using the “arrow” tool.

“Dot” (Standard) - add graphic shapes to a view by selecting a graphic shape type
from the drop down menu of layout options (i.e., points, lines, boxes). Graphic
shapes have no database associated with them, and are added to add emphasis or
clarify database objects (shapes) in a view.

“Z" (Custom) - zoom the Standard View in or out by clicking, holding and dragging
a box IN THE INDEX VIEW to any size. The Standard View will adjust to match the
view area shown by the black box in the index view. This tool will not work inside
the Standard View, or any other view for that matter.

“P” (Custom) - pan the Standard View by clicking on the edge of the black box,
holding and dragging that box in any direction IN THE INDEX. The Standard View
will adjust to match the view area shown by the black box in the index view. This
tool will not work inside the Standard View, or any other view for that matter.

“Polygon” (Custom) — Selects features of the active layer using a user defined
polygon.

“Hut” (Custom) - Generates a tax information report on the selected parcel.

* “Frame” (Custom) — Enabled when Pima County Development Services’ Subdivision
Plat image viewer has been purchased and installed.
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B. Common Operations

These directions will help guide new users through some of the routine operations
typically used in the program.

1. Changing Scale-Dependent Display

The program comes with pre-set scale thresholds designed to aid in map clarity and
legibility.

Typically you do not want to see a mass of parcel lines when you are looking at a map of
the entire county, so the parcel lines threshold of visibility is set to 1:30,000 scale.
Other layers with pre-set scale dependency include; Street Centerlines (1:100,000),
and Topography (1:500,000). If you would like to alter these settings follow these
steps.

» Click the theme name in the View Table of Contents to activate it.

» Select Theme Properties from the Standard View Menu “Theme” pulldown.

» Click on the Display icon in the Theme Properties menu.

* Adjust minimum or maximum scales by typing values in the spaces provided.
* Click “OK” to finish operation.

1. Finding A Parcel
* Click your mouse on the “Locate By” pull down menu or select the binocular button.
» Click one of the five options:

Taxcode — select from either single parcel or from a range.

Single - enter at least the first five digits of the property’s taxcode number. If
you enter less than the full 9 digits, or if the 9-digit number you entered is not
found, you will be presented with a scroll-list of taxcode numbers that match the
first five digits. The scroll list will also display the situs address next to each
number to aid you in identifying the property. Choose a number by clicking it
and then click the “OK” button.

Within a Range - enter the lowest 9-digit taxcode number of the range. Then
enter the highest 9-digit taxcode number of the range.

Address - enter the address number, a street-prefix direction and at least the first
five characters of the Street Name, then click the “OK” button.

Owner’s Name - enter the first five characters of the owner’s last name, then click
the “OK” button. You will be presented with a scroll-list of last names that match
the five characters you entered. The scroll list will also display the situs address
next to each name to aid you in identifying the property. Choose a name by
clicking it and then click the “OK” button.

Book/Map — enter the Assessor's 3-digit book number. Then enter the 2-digit
Assessor's map number.

Map/Plat - enter the Assessor’'s 2-digit map number. Then enter the 3-digit
Assessor’s plat number.

» The program will locate the parcel you selected, and zoom the standard view to

1:6800 scale with the selected parcel in the center of the view.
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Hints:

You can double click any of the options described above to avoid having to click the
“OK” button each time.

Due to time lags between the time a parcel is recorded and the time it appears in
the database, some valid taxcode, addresses, or owner’'s names you enter will not
be found. You can use the “Road Intersection” menu item or the “Locate Address”
button (looks like a push-pin on the button bar) to find the nearest intersection or
approximate address location. From there, use the “Identify” tool to click on
surrounding parcels to find the parcel in which you are interested. Please note that
the Parcel theme must be active and visible in order to use the identify tool on it.

1. Locating An Address

Click the “Push Pin” button.

Enter an address which includes Street Number(e.g., 34560) Street prefix , N, S,
E. W), and a Street Name.

Click “OK”

A black dot appears on the approximate location of the address.

1. Finding A Road Intersection.

Select Road Intersection from the Locate By menu pulldown.
Type an intersection - as shown in the provided example.
Click “Properties” to set geomatching attributes - if needed.
Click “OK”

To remove the intersection graphic created by the above processes, select (with
arrow tool) and choose Delete Graphic from the Edit menu pulldown.

1. Labeling Features

Select theme to label by clicking theme name in View window.
Select Properties from the Theme menu pulldown.

Click the Text Labels “Tag” icon.

Select label properties from the vertical scroll bar options.
Click “OK”.

Position the pointing device over the feature you wish to label.
Click pointing device to add label. Repeat as needed

To remove the labels, created by the above processes, select (with arrow tool) and
choose Delete Graphic from the Edit menu pulldown
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1. Making a Print or Plot (standard maps)
* Input title and sub-title lines into the Titles form and click “OK”.
» Left- Select Standard from the Maps menu pulldown and click “OK”.
* Choose print options from the Page Setup form and click “OK”.
» Choose any additional options from the Print Setup form and click “OK”.
* Click “YES” to delete the layout and return to the program.

Note: ArcView's Layout window maximizes the Standard View for clarity. When you
return to the normal windows after composing a layout,the Standard View needs to be
re-sized by clicking on the re-size icon in the upper right corner.

1. Making Mailing Labels

If you have a printer that you can set up to print mailing labels in one of three standard
Avery Label formats (5160, 5161, or 5162), the PCLIS program will provide menus to
spool to those formats. The mailing list is comprised of the current selected set of
parcels. Be sure to do all of your queries and analyses prior to generating the mailing
labels. Also note that certain queries and analyses automatically select the 9999
series of parcels (representing public roads, easements, drainageways, and unknown
parcel numbers). If you don't select these out of your set, you will get mail labels for
these unaddressed parcels.

To make labels:
* Click the “Two Brackets” Standard View button [Z] .
» Select Situs (parcel) or Owner’s address from the menu. Click OK.
» Determine if you want parcel numbers on the label. Click “Yes” or “No”.
» Select a mail label style from the choices presented in the vertical scroll box. Click
“OK”.
» Choose one of three spooling options from the vertical scroll bar.
» Select a time from the many time options available.
» Click “Print” to finish the operation.
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V. Database information

The data provided on the GIS Query System CD has some known errors (Also, please
read the data disclaimer that appears at program start-up):

» The parcel data is a snapshot as of one week prior to the release date. This
information lags from one to several months behind the filing of recorded plats and lot
splits at the Pima County Recorders office.

» Additional layers provided on the CD may or may not register to the parcel base or to
each other. These layers were developed in the context of special projects, are
snhapshots of the layer at that time, and were registered to a variety of source maps.

We intend to produce a new CD on a quarterly basis, with whatever data updates have
been made in the meantime. The purpose in distributing this “snapshot” data is to provide
a tool for very rough, regional type analyses, where up-to-the minute data is not critical.
You should not rely on this information for legal or engineering purposes. Over the next
several months and years, we hope to improve the quality of the data in this product.
Given the dynamic nature of some of the datasets involved, it will always be approximate.
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VI. Uninstalling PCLIS Software

NT and Win95 Systems
1. Open the Operating System’s Control Panel window. This is typically found by clicking

Start on the MS-Windows taskbar, following the arrow to display Settings choices, and

clicking Control Panel.

2. In the Control Panel window there should be an Add/Remove Programs icon. Select
this program by double-clicking the icon.

3. Make sure the Install/Uninstall tab at the top of the form is selected.

4. In the vertical scroll bar portion of the form, highlight the program name which you wish

to uninstall by clicking with the pointing device.

Click the “Add/Remove” button.

A Confirm File Deletion form will prompt you to verify your choice. Answer “Yes” by

clicking this button to complete the transaction.

* On some systems, files used by the PCLIS are shared files which have been
used by other programs on your computer. If these files exist, Uninstall prompts
you with a Remove Shared Files form. Although the operating system will
indicate that the file is no longer needed, we recommend selecting “No” by
clicking this button. Doing this will ensure that you don’t inadvertently delete
files which your system may need later.

7. When the process is completed, as indicated by the status bar, click “OK” to exit.

o o

Warning:

Uninstall leaves certain system variables open on a Win95 uninstall. These variables are
harmless, but if you wish to remove them you will have to edit your autoexec.bat file.
Delete the lines beginning with gisdata, gisindata, gistemp, gismail, and gislegend, then
re-boot your computer. Uninstall may also leave its directory structure in place on both
Win95 an NT. Check your system for these problems after performing an uninstall.

Windows 3.51
Double click the uninstall icon which will be found in the program group that was created
during the installation.
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VII. Getting Help
Help Menu

There are many help options accessible from the help pull-down menus inside the PCLIS
program. Many times the answer to your general ArcView questions will be found here.

Email and Mail

Pima County DOT, Technical Services Division has established the following e-mail
address for you to send us comments and questions about the PC Land Information
System.

pclis@dot.co.pima.az.us

As time allows, we will try respond to your e-mail, but we cannot guarantee a response.
We will consider your input when making revisions to future releases. Program
improvements and data updates will be available by purchasing subsequent editions of
the CD. No interim updates or patches will be provided. Please let us know if you have
suggestions for improving the data and/or the application. We want to hear from you.

You can also mail comments to:

CD-ROM Group

Pima County Department of Transportation
Technical Services Division

201 N. Stone Avenue, Suite 910

Tucson, AZ 85701

WE ARE SORRY THAT DUE TO RESOURCE CONSTRAINTS WE CANNOT ACCEPT
PHONE CALLS RELATED TO THIS PRODUCT.
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